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CSiBridge v24.2.0 Release Notes
© 2023 Computers and Structures, Inc.

Notice Date: 14-February-2023

This document lists changes made to CSiBridge since v24.1.0, released 11-October-2022. Items marked
with an asterisk (*) in the first column are more significant.

Bridge Design and Rating
Enhancements Implemented
* Ticket Description
* 8822 An enhancement has been implemented to provide comprehensive calculation reports in

Word format for the following Chinese JTG 3362-2018 bridge superstructure design checks:
Concrete Box - Shear Only, Concrete Box - Torsion Only, and Concrete Box - Shear and
Torsion.

* 9213 Bridge superstructure design and rating of steel I-girder and U-girder bridges per the
AASHTO code have been changed so that the calculated depth of web in compression for
negative bending in cases where the slab is specified as resisting tension is now based on the
negative yield moment. Previously the depth of web in compression for negative bending
was calculated as equal to depth of web in tension for positive yield moment. In
design/rating requests where the slab was assumed as resisting unlimited tension this
resulted in an overly conservative depth of web in compression. Impacted design requests:
Steel I and Steel U Service. Impacted rating requests: Steel I and Steel U Service. Impacted
design and rating Codes: AASHTO LRFD, All Editions.

9227 An enhancement has been implemented to improve the warning messages regarding the
design and rating of steel I-girder bridge objects that are displayed when updating the bridge
object, modifying a bridge superstructure design/rating request, or running a bridge
superstructure design/rating request. Specific cases include:(1.) When (a) there are I-girder
section transitions, staggered diaphragms, and/or staggered splices in the bridge object,
then complete results are available for design/rating at all the global/local section cuts if (b)
the steel I-girder is modeled as Mixed or Area objects, the option "Mesh Slab at Critical
Steel-I-Girder Locations" in the Update Bridge Structural Model form is checked, and the
Live Load Distribution Method of design/rating requests is "Use Directly Girder Forces from
Analysis". If any of conditions (b) are not met, then a warning will be produced that
design/rating results may be approximate at the global section cuts. In the case of spine
models, the girder responses are not available, and thus the "Use Directly Girder Forces
from Analysis" is not allowed. (2.) When there are no I-girder section transitions, staggered
diaphragms, and/or staggered splices in the bridge object, then complete results are
available for design/rating at all the global section cuts EXCEPT when the bridge object is
updated as a spine model and the Live Load Distribution Method of design/rating requests is
"Use Directly Girder Forces from Analysis". In the latter case, a warning will be issued.

Bridge Modeler
Enhancements Implemented
* Ticket Description

9116 The Bridge Modeler has been changed to now generate the exterior support bearings for
concrete box sections of types Advanced, Exterior Girders Clipped, and Exterior Girders with
Radius directly below the point where the sloping or curved sides of the section meet the
horizontal bottom of the section. Previously the bearings could be generated and connected
at a more outward location on the curved or sloping wall of the section. This change will
affect newly created models and models from previous versions if affected bridge objects
are updated in the new version. This behavior is generally more realistic than the previous
approach.
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* Ticket Description
9194 An enhancement has been implemented for the Bridge Modeler to provide more flexibility

in modeling bridge bents connected directly to ground or to separately modeled
substructures. A new option, "Support Type", has been added to the bent property
definition with options Column, Foundation Spring, and None. These define how the bent
connects the superstructure to ground, whether directly from the bottom of the bearings or
through a cap beam. (1.) Column: This provides the previous behavior where one or more
columns are defined which connect the cap beam to ground, or which connect directly to
the bottom of the bearings if no cap beam is specified. Connection to ground is specified
separately at the bottom of each column. (2.) Foundation Spring: This requires the
specification of a foundation spring property which is then applied as a line spring to the
bottom of the cap beam, or which is applied as a point spring to the bottom of each bearing
if no cap beam is specified. The behavior is similar to an abutment property. (3.) None: No
columns or foundation springs connect the cap beam to ground, if present, nor connect the
bottom of the bearings to ground if no cap beam is specified. This option assumes the
substructure is defined externally to the bridge object or as part of an adjacent bridge
object. Similarly, a None option has been added to the abutment property definition for use
if the abutment substructure is defined externally to the bridge object. Additionally, the
Typical Bent form under the New Model > Quick General Bridge Template now provides a
None option.

9232 The efficiency of updating bridge objects and generating analysis models has been improved
by no longer calculating the notional size of the entire bridge section at each section cut
except for concrete bridges with concrete box, flat slab and Tee-beam bridge sections
modeled as spine models. In addition, a minor speed increase has been achieved for
calculating bridge loads when creating the analysis model. Results are not affected.

* 9267 The Bridge Modeler has been enhanced by adding four new circular segment types to the
bridge layout line definition. These are: "Circle Right to Station by Radius", "Circle Left to
Station by Radius", "Circle Right to New Bearing at Station" and "Circle Left to New Bearing
at Station." When specifying a circular segment by radius, the bearing of the end station is
calculated. When specifying a circular segment by bearing, the radius is calculated. In
addition, whenever the end bearing of any segment is changed, the end bearings of all
subsequent segments are automatically updated by the same change in angle until the first
"Straight at New Bearing" segment is encountered, if any. This includes the new Circle
Right/Left by Radius commands, which may cause a change in end bearing angle for the
segment. When working with "PI to PI" data, any set of three points that define a perfect
circle with no straight segments and no spirals will be converted to a segment of type Circle
Right/Left to New Bearing at Station.

Data Files
Enhancements Implemented
* Ticket Description

9337 Minor corrections have been made to the Chinese frame-section database file
ChineseGB08.xml. These include (1.) Changing section name YB-WH700X300X12X38 to YB-
WH700X300X12X28, with the corresponding change in flange thickness, and (2.) Minor
changes to the section moduli of several sections. No section property values affecting
analysis were changed, and the effects on design properties is insignificant. These changes
only affect models that import these properties from the new database file. Models that
imported properties from an earlier database file will not be affected.
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Database Tables
Enhancements Implemented
* Ticket Description

9206 An enhancement has been implemented to include the program name, program version,
and the version for each table in the export of table and field keys to the XML file from
within the software. Additionally, the menu command for this export has been modified to
"Options > Database > Write Table and Field Keys to XML File" to better reflect the
information being exported. Previously, the command was "Options > Database > Write
Default Table Names to XML". In the ribbon mode, the option to export the XML file is
available via a command button named "Write Table and Field Keys to XML File" under "File
> Settings > Database Table Utilities and Settings". The resulting XML file as applied to all
possible tables is now automatically included in the installation folder. This can be compared
between versions of the software to see which tables have been changed. This information
can be used to update programs and scripts that work with exported/imported database
tables or API applications that use the table functions for editing and/or display.

Installation and Licensing
Enhancements Implemented
* Ticket Description

9008 The version number has been changed to v24.2.0 for a new intermediate release.

Loading
Enhancements Implemented
* Ticket Description
* 1317 Temperature loads applied to bridge objects are now automatically applied to their bridge

tendons. This feature is only applicable to tendons modeled as elements. Tendons modeled
as loads are not affected by temperature loading. For temperature gradients, each
discretized tendon element is loaded by the average temperature at the two ends of the
element, based on depth of the element in the bridge section. The effect of tendon
discretization on temperature-gradient loading is generally negligible.

* 7148 Temperature loading can now be defined to act on rail tracks. Different temperature
increments can be specified to be applied to one or more station ranges along each rail track
in any load pattern. When these load patterns are used in a nonlinear static or staged
construction load case, temperature loading may cause longitudinal slippage, depending
upon the track support properties. Buckling of rail tracks under temperature loading can also
be considered using linear buckling load cases or nonlinear static load cases with P-delta.
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Analysis
Incidents Resolved
* Ticket Description
* 8981 An incident was resolved where moving-load analysis could terminate while performing the

vehicle influence analysis in models with a large number of vehicles with many different
wheel configurations and a relatively small number of influence stations along the length of
the lanes. When this occurred, results were not available. This was not common.

* 9051 An incident was resolved for the Bridge Modeler where exporting and re-importing a model
with a bridge wind load applied that created more than six wind angles would generate an
error message when running the analysis. After closing the error message, the analysis
would run, but no load assigned as part of the Bridge Object definition (point, line, or area
loads) would be applied.

Bridge Design and Rating
Incidents Resolved
* Ticket Description

9030 An incident was resolved for AASHTO substructure bent column design where the design
request failed and no design request results were available when any of the design station
ranges contained invalid resistance section property. While the "Bridge Design Request -
Substructure" form allows to input only valid resistance section properties (prismatic
concrete sections), an invalid resistance section (such as nonprismatic concrete section or
steel section) could be input via interactive database editing. Now the design request will
produce both tabular and Excel report results for design station ranges with valid resistance
properties and will indicate that no design results are available for design station ranges
with invalid resistance section properties.

* 9059 An incident was resolved for bridge superstructure design of steel U-girder bridge sections
where the Constructability Staged design request would fail to run when the generated
bridge model contained a local girder section cut due to a staggered diaphragm, splice, or
section transition on a steel U-girder. This problem was due to the fact that the slab area
objects above the girder local cut were not meshed accordingly. The affected design request
type was "Steel-U Comp Construct Stgd." for all codes that support this type of design:
AASHTO LRFD 2012, 2014, 2017, 2020; CAN/CSA-S6-14, -20; EuroCode; and IRC-2011.

9071 An incident was resolved for bridge superstructure design of steel I-girder bridge sections
per the AASHTO code where the strength check was incorrectly reporting the value for P2N
as P1N, and vice-versa, for Eqn. 6.10.10.4.2-7 and -8. The values were correct, and the
column descriptions were consistent with what was reported, but not with naming
convention per AASHTO. The labeling has been switched in the design output tables to
match the AASHTO names for these two quantities. No results were affected. The
calculation report was not affected since the nomenclature P1n and P2n is not used there.
Impacted codes: AASHTO - all versions. Impacted design requests: Steel I Strength.

* 9178 An incident was resolved for the bridge response, design and rating of concrete box girder
bridges where the secondary (hyperstatic) effect of bridge tendons was not properly
captured at bridge section cuts for tendons that were located in sloped exterior webs. In
particular, the determination of whether the tendons were inside the exterior webs was
assuming the webs were vertical, and this could exclude tendons at section cuts where
tendons were closer to the bottom of the web, depending on the slope and thickness of the
web. Section cuts where the tendon was closer to the top of the web were not affected. In
the Bridge Object Response Display form, plots of bridge and girder forces and stresses with
the option "Include Tendon Forces" selected could be affected. Results for the two tables
"Bridge Object Forces with Tendons" and "Bridge Object Girder Forces with Tendons" could
be affected. Concrete box girder bridge design and rating requests that consider secondary
prestress forces could be affected. No other results were affected. Only version 24.1.0 was
affected.
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* Ticket Description
9274 An Incident was resolved where saving a model with at least one bridge substructure design

request defined but no bridge superstructure design requests defined would generate the
error message "Error saving Model", and the model was not saved. Running analysis for such
a model would generate the same error and the analysis would not run.

Bridge Modeler
Incidents Resolved
* Ticket Description

8374 An incident was resolved for the Bridge Modeler where bridge models with a user-defined
bridge section could not be updated as an area (shell) or solid models unless both the area-
and solid-model mesh had been defined in Section Designer for the bridge section. On the
Update Bridge Structural Model form, the Structural Model Options only allowed spine
models if no solid mesh had been defined, and only allowed spine and area-object models if
the only a solid mesh had been defined. In the latter case, choosing the area-object option
did not produce a bridge model. Updating the bridge object as a spine model was the only
effective option unless both mesh types had been defined.

8727 An incident was resolved for the Bridge Modeler where bridge objects using the advanced
box-girder bridge section would not be updated if all the fillets at the left-bottom slab were
specified as zero but some of the fillets at the right-bottom slab were not zero.

8781 An incident was resolved for the Bridge Modeler where, for a bent specified to have no cap
beam, the support bearing above a bent column would connect to the bottom of the bridge
slab at a wrong location when (1) bridge section cut was skewed at the bent location, and (2)
the horizontal offset from the bridge centerline to reference line was nonzero. When this
occurred, the effect was obvious in the generated model, and results agreed with the model
as generated.

8938 An incident has been resolved for steel I-girder and U-girder bridge design/rating in which
the design/rating might have failed if staggered diaphragms with layout line as the reference
line were assigned in between two bridge section cuts near a highly skewed support.

* 9017 An incident was resolved for the Bridge Modeler where the elevation of generated bridge
tendons could be incorrect for concrete box-girder bridges where the bridge section had
nonzero superelevation and when the option to keep the girders vertical when
superelevated was set to "Yes". Tendons defined with respect to the bridge centerline did
not account for superelevation at all. Tendons defined with respect to a bridge girder could
have their elevation incorrect, upward or downward, by an amount on the order of the
vertical offset created by superelevation. The effect of this was visually obvious and results
agreed with the model as generated. Bridge sections where the option to keep the girders
vertical when superelevated was set to "No" were not affected. This issue only affected
v24.0.0 and v24.1.0, where the tendon location should be updated with changes in
superelevation. For prior versions, bridge tendons were correctly generated based on the
superelevation at that time, but were not subsequently adjusted with changes in
superelevation.

9039 An incident was resolved for the Bridge Modeler where the frame objects representing a
diaphragm would not be generated if the diaphragm was assigned to the end of a span with
no bent property specified, and the superstructure continuity condition was set to be
continuous. When this occurred, results agreed with the model as generated.

9088 An incident was resolved for the Bridge Modeler where, for curved bridges with composite
bridge sections, bridge tendons defined with respect to a girder reference line were being
generated along the curved geometry even if the girders had been specified to remain
straight in the bridge section definition. When this occurred, tendons intended to be located
inside the girders could fall outside of them. Results agreed with the model as generated.
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* Ticket Description
9103 An incident was resolved for the Bridge Modeler where attempting to run the analysis of a

steel I-girder bridge that had been updated as a spine model would produce an error
message when there were staged construction load cases containing Pour Concrete and/or
Remove Forms operation for that bridge object, and then the analysis would not run. Now
instead, a warning message will be provided and the affected load cases will not be run,
including any subsequent load cases that depend upon the affected staged construction load
cases. Unaffected load cases will still be run. The Pour Concrete and Remove Forms
operations do require the associated bridge object to be updated as an area model.

9160 An incident has been resolved for a minor issue with double bearing links generation for
precast I-girder bridge area models in which the program redundantly generated two fixed
links between the bridge deck and bearing link at the before location of the double bearing
bent. This issue did not affect the analysis or design results.

* 9234 An incident was resolved for the Bridge Modeler where, under certain conditions, incorrect
frame sections could be assigned to steel members in a bridge object. This could affect
models that contained two or more bridge objects as well as some manually defined steel
members, and for which some steel frame-design operations had been performed. Such
frame-design operations could include running steel frame design or assigning steel frame-
design overwrites. When this error occurred, the frame section property assignments were
correct after updating the bridge objects, but could become incorrect after running the
analysis. This did not occur if the model was saved and reopened after updating the bridge
objects and before running the analysis. Models that exhibited this error could be corrected
in previous versions of the software by updating the bridge objects, saving and reopening
the model, and then running the analysis. Affected models opened in the new version will
need their bridge objects updated to correct the assignments. However, it is no longer
necessary to save and reopen the model before running the analysis.

* 9240 An incident was resolved for the Bridge Modeler where any program-generated bridge
groups, as well as transverse and longitudinal stiffeners for steel bridge girders, were not
properly corrected after deleting a bridge span until after the bridge object was updated.
Before the bridge object was updated, the program-generated bridge group data and
stiffener data, if any, could refer to the wrong span or no span, and the database tables for
these items could be empty. If the model was then saved before updating the bridge object,
the model could become corrupt and might not have been able to recover. Models where
the stiffener definitions were corrupted in previous versions should be checked in the new
version, and may require the stiffeners to be redefined and the bridge object updated, but
this corruption should not occur again. It is still generally recommended practice to update a
bridge object after major changes to it, and before saving the model, to assure full
compatibility of all components.

Data Files
Incidents Resolved
* Ticket Description

8635 An incident was resolved where the solid object edge constraint assignment could get lost
when exporting a model to text file (.$BR or .B2K) or a database-table file (Excel, Access,
XML) and importing it back in. This could have occurred if the solid objects were generated
using the extrude area to solid command. When this did occur, the results agreed with the
model as imported (i.e. no solid edge constraints).

9302 An incident was resolved where importing a model from the text file (.$BR) or from a
database-table file (Excel, Access, XML) would set the bridge superstructure rating
preference item "Rating Resistance Code Amendments" to "No Amendments" when the
"Rating Resistance Code" was set to "AASHTO LRFD 2017" or "AASHTO LRFD 2020", even if
the value of "Amendments" had been set to "PennDOT" when the file was saved. This did
not affect models where the "Rating Resistance Code" was set to "AASHTO LRFD 2014". The
Amendments" item does not apply to other rating resistance codes. Rating results would
agree with the model as imported.
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Drafting and Editing
Incidents Resolved
* Ticket Description

7243 An incident was resolved where solid elements were not shown in 2D views when they were
cut by the viewing plane, even though they were able to be selected in the view. Now the
following behavior determines how solid elements can be viewed and selected in 2D views,
which include the XY, XZ, and YZ planes as well as developed elevations: (1.) The face of the
solid element will be shown if it is within the cutting-plane depth and behind the cutting
plane. The cutting-plane depth is set using command File > Settings > Tolerances. When
viewing from the front of the viewing plane, only faces that are on or behind the plane will
be shown. When viewing from the back of the viewing plane, only faces that are on or in
front of the plane will be shown. As a limitation, when viewing the XY plane in DirectX
graphics mode, only faces on or below the plane will be shown even when viewing from
below. (2.) If the viewing plane cuts the solid element and the faces are outside the cutting-
plane depth, then the cut cross section of the solid will be shown. (3.) When viewing solid
contour displays in 2D views, the contours on the solid face or the cut cross section will be
shown as interpolated from the joints. However, numerical values at the mouse cursor will
not be displayed..

Graphics
Incidents Resolved
* Ticket Description

8849 An incident was resolved where the contour legend was not shown when drawing influence-
surface contours in DirectX mode. The displayed values were otherwise not affected.

Loading
Incidents Resolved
* Ticket Description
* 9114 An incident was resolved where the lane loading points could be incorrect where the lane

was applied to triangular area objects. When this occurred, the loading points could be
located outside the expected lane area, causing a very slight error in the distribution of the
lane load to the area object. The error was obvious when displaying the lane loading points.
This was not common for bridge objects, since the slab surface does not generally use
triangular area objects. However, it could occur for a bridge object when triangular area
objects were generated for the diaphragms and also the Objects Loaded by Lane was set to
group ALL rather than using the Program Determined option.

Results Display and Output
Incidents Resolved
* Ticket Description

9183 An incident was resolved where, when scrolling over the graphical display of the deformed
shape, the values of joint displacement shown at the mouse cursor were given in the global
coordinate system (or the selected user coordinate system) rather than in the joint local
coordinate system, even though they were labelled as being for U1, U2, ..., R3. No other
results were affected. In particular, values shown when right-clicking on the joint were
correctly given in the joint local coordinate system. This issue only affected v24.1.0. Previous
versions were not affected.
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Structural Model
Incidents Resolved
* Ticket Description

9310 An incident was resolved where drawn section cut on screen results were different in some
cases when saved as quad section cuts. The saved quad section cut results were in error
when edge constraints were present. If edge constraints were cut they were being included
in the results even if the area element they belonged too were not to be included in the
results.

User Interface
Incidents Resolved
* Ticket Description

7388 An incident was resolved for the Bridge Modeler affecting the assignment of bridge
temperature loads using the Assign Bridge Temperature Loads form: (1.) Additional bridge
temperature loads were permitted to be assigned to the same load pattern that was being
used to apply temperature loads in the bridge section definition that was used for the
current span. This would generate an additional but unused bridge temperature load that
could be confusing, although it did not affect the analysis results. (2.) The program-
generated temperature load based on the bridge-section temperature load assignment was
incorrectly allowed to be deleted, removing the load from the analysis. Now this can only be
changed in the bridge section definition.

8590 An incident was resolved where the units for rotational displacements were shown as
degrees instead of radians in the headings of the tables generated from the Bridge Response
Display form. The numerical results themselves were correct and given in radian units,
consistent with rotational displacements displayed and tabulated elsewhere in the software.

* 8935 An incident was resolved where an abnormal termination of the software could occur when
opening the Bridge Group form (ribbon Bridge > Bridge Objects > Groups) when there were
no bent properties defined in the model, even if no bent properties were being used in the
bridge object(s).

9108 An incident has been resolved in the Bridge Bent Column Data form in which the following
three fields could not be changed: (1) Stiff Reduct Fact in Column Data table, (2) and (3) Eff
Length Fact M33 and M22 in Moment Release at Top of Column table.

9228 An incident was resolved for the Bridge Modeler where the diaphragm types Chord and
Brace, Single Beam and Steel Plate could not be defined if the were no existing steel frame
section properties defined in the model. This restriction has been removed, and the required
steel frame section properties can now be added while the diaphragm is being defined.


